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Topic 1: Set the Mode of Communication 

TOPIC 1: SET THE MODE OF COMMUNICATION 

INTRODUCTION 

Setting the Mode of Communication is an important step in ensuring that Trade Account Owners (TAOs), Proxy 

Trade Account Owners (PTAOs), and trade account users can receive, review, and respond to CBP forms via the 

ACE Forms application.  

Mode of Communication applies to how the trade receives and responds to CBP forms. The modes of 

communication are Mail (via U.S. Postal Service) and Portal (via the ACE Forms application). If a Mode of 

Communication is not set, the default communication for CBP forms is U.S. Postal Service mail.  

TAOs must select the Mode of Communication for CBP Forms. 

NOTE: TAOs may also authorize PTAOs and other trade account users to view and/or modify Mode of 

Communication settings. Refer to Topic 2: TAOs – Authorize Access to Mode of Communication 

for steps to edit Mode of Communication user permissions. 

You can select the Mode of Communication at either the top account level or the sub-account (importer of 

record) level. 

If you select the mode at the top account level, and select Yes in response to the Apply these settings to all 

accounts under this top account question, all forms pertaining to the top account and any of the sub-accounts will 

be sent by the selected Mode of Communication.  

If you select the Mode of Communication at the sub-account level, then that mode will only apply to the selected 

sub-account. 

SET THE MODE OF COMMUNICATION 

1. Select the Accounts tab.
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2. In the Task Selector pane:

a. In the Select Account Type section, in the View drop-down menu,
select Importer.

b. Select the Go button.

c. In the Select Task section, select the Mode of Communication
hyperlink.

NOTE: To set the Mode of Communication at the sub-
account level, you will need to select the sub-account 
before selecting the Mode of Communication hyperlink. 

3. In the Mode of Communication Settings pane, select the Edit button.

4. In the Mode of Communication (Post-Release) section:

a. Select a Modes checkbox(es) to indicate your communication preference.

IMPORTANT: You can select both Mail and Portal as your Mode of 
Communication. You will then be able to view and respond to CBP forms via 
the ACE Forms application as well as receive a mailed copy. Selecting Portal 
does not obligate you to respond via the ACE Forms application. 

b. Select the Yes or No radio button option to indicate if settings should apply to all
accounts.

5. Select the Save button to confirm the settings.

NOTE: You may change the Mode of Communication settings at any time by 
completing the above steps 1-3 to access the Edit button, and then completing 
steps 4 and 5 to modify and save changes.  
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TOPIC 2: TAOS – AUTHORIZE ACCESS TO MODE OF COMMUNICATION 

INTRODUCTION 

TAOs may authorize PTAOs and other trade account users to view and/or modify Mode of Communication settings. 

IMPORTANT: Changes made by authorized PTAOs and trade account users apply at the account level 

and for all users. Changes are not applied as individual user settings for the PTAO or trade account 

user making the changes. 

TAOS – SET MODE OF COMMUNICATION PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS

1. Select the Tools tab.

2. In the Task Selector pane, select the User Access hyperlink.

3. In the User Access pane, in the Last Name column, select the last name hyperlink of the
user to edit.

4. In the Account User Information section:

a. Edit the User Role and/or Access to Top Account options as needed.

b. Select the Continue button.
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I 

5. In the Single Sign-on Partner Access section:

a. Select the Importer sub-tab to change the importer account type permissions.

b. Select the Edit Importer Permissions hyperlink.

6. In the Authorized Tab Access section:

a. In the Mode of Communication row, select the
No Access, Read Only Access, or Full Access
radio button.

NOTE: Full Access allows the user to 
create, maintain and display the Mode of 
Communication. Read Only Access 
allows the user to view the Mode of 
Communication. No Access prevents 
access to the Mode of Communication 
hyperlink. 

b. Select Continue.

7. The Permission column displays the updated settings. Select the Save button.



Quick Reference Guide 
CBP Modernized Forms 

January 2024 
Publication No. 3095-0323  

Topic 3: TAOs – Authorize Access to CBP Forms 

TOPIC 3: TAOS – AUTHORIZE ACCESS TO CBP FORMS 

INTRODUCTION 

In addition to granting access to the Mode of Communication hyperlink, the TAO must set CBP Forms 

permissions for PTAOs and authorized trade account users.  

The ACE Forms application allows authorized users to receive and respond to U.S. Customs and Border 

Protection (CBP) forms and requests: 

• CBP Form 28: Request for Information

• CBP Form 29: Notice of Action

• CBP Form 4647: Notice to Mark/Notice to Re-Deliver

• CBP Form 6051D: Notice of Detention

• CBP Documents Required Notifications

You must complete the following actions to receive, review, and respond to CBP forms in the ACE Forms 

application: 

1. The account Mode of Communication must be set to Portal.

2. The TAO must authorize access to CBP Forms for PTAOs and/or other trade account users as needed.

Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can 

receive, view, search and respond to CBP Forms through the ACE Forms application. 

NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are 

not required to respond through the ACE Forms application. They may submit responses through the 

ACE Forms application or to CBP at the port of entry where the entry summary is filed. 
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SET CBP FORMS PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS 

1. Select the Tools tab.

2. In the Task Selector pane, select the User Access hyperlink.

3. In the User Access pane, in the Last Name column, select the last name hyperlink of the
user to edit.

4. In the Account User Information section:

a. Edit the User Role and/or Access To Top Account options if needed.

b. Select the Continue button to view the current access for the user.
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5. In the Single Sign-on Partner Access section:

a. To edit importer permissions, select the Importer sub-tab.

NOTE: To edit broker permissions, in the Broker sub-tab, select the Edit 
Broker Permissions hyperlink.

b. Select the Edit Importer Permissions hyperlink.

6. In the Authorized Tab Access section:

a. In the CBP Forms row, select the No Access or Full Access radio button.

NOTE: Full Access allows the user to view and respond to CBP Forms in the 
ACE Forms Application. No Access prevents access to CBP Forms. Read Only 
Access is NOT available for CBP Forms.  

b. Select Continue.
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7. The Permission column displays the updated settings. Select the Save button.
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TOPIC 4: ACCESS THE ACE FORMS APPLICATION THROUGH MODERNIZED ACE 

INTRODUCTION 

The Modernized ACE Forms application allows users to view and manage electronic versions of CBP Forms. 

A key upgrade in CBP Forms is the Courtesy Copy feature:  

When CBP issues a form, brokers now have the option to receive an electronic courtesy copy of the form via 

email, using the primary point of contact’s email address associated with a broker’s ACE Portal account (sub-

account level).  

To receive the electronic courtesy copy, the Mode of Communication must be set to Portal and/or Mail in the 

importer’s ACE Portal Account and the broker’s ACE Portal account.  

For assistance with access and login to the Modernized ACE Portal, refer to the Modernized ACE Portal – 

Create Account and Login QRG. 

ACCESS FORMS THROUGH MODERNIZED ACE

1. Login to the ACE Modernized Portal.

2. Select the Accounts tab.

3. Select Importer.

4. In the Account Name column, select the importer name hyperlink.

5. In the Importer Account page, select the Forms button.

https://www.cbp.gov/document/guidance/modernized-ace-portal-create-account-and-log
https://www.cbp.gov/document/guidance/modernized-ace-portal-create-account-and-log
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The ACE Forms application displays. 

6. In the Search Forms pane:

a. In the Entry Number field, type an entry number.

b. Select the Search button.

NOTE: There are two other ways to search for forms requiring a response: 

Advanced Search hyperlink in the Search Forms pane. 

Pending Response hyperlink in the Trade Hotlist pane. 

NOTE: Select the Overdue hyperlink in the Trade Hotlist pane to display the list 
of overdue forms. Overdue notices are based on the due date of the form. 
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TOPIC 5: RESPOND TO CBP FORM 28: REQUEST FOR INFORMATION

INTRODUCTION 

You can review and respond to a Form 28 in the CBP Forms application. 

COMPLETE A FORM 28 RESPONSE 

1. Access CBP Forms.

2. If needed, refer to Topic 3: TAOs – Authorize Access to CBP Forms

3. Introduction

In addition to granting access to the Mode of Communication hyperlink, the TAO must set CBP Forms 

permissions for PTAOs and authorized trade account users.  

The ACE Forms application allows authorized users to receive and respond to U.S. Customs and Border 

Protection (CBP) forms and requests: 

• CBP Form 28: Request for Information

• CBP Form 29: Notice of Action

• CBP Form 4647: Notice to Mark/Notice to Re-Deliver

• CBP Form 6051D: Notice of Detention

• CBP Documents Required Notifications

You must complete the following actions to receive, review, and respond to CBP forms in the ACE Forms 

application: 

3. The account Mode of Communication must be set to Portal.

4. The TAO must authorize access to CBP Forms for PTAOs and/or other trade account users as needed.

Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can 

receive, view, search and respond to CBP Forms through the ACE Forms application. 
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NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required 

to respond through the ACE Forms application. They may submit responses through the ACE Forms application 

or to CBP at the port of entry where the entry summary is filed. 
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SET CBP FORMS PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS 

4. Select the Tools tab.

5. In the Task Selector pane, select the User Access hyperlink.

6. In the User Access pane, in the Last Name column, select the last name hyperlink of the
user to edit.

7. In the Account User Information section:

c. Edit the User Role and/or Access To Top Account options if needed.

d. Select the Continue button to view the current access for the user.
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8. In the Single Sign-on Partner Access section:

e. To edit importer permissions, select the Importer sub-tab.

NOTE: To edit broker permissions, in the Broker sub-tab, select the Edit Broker
Permissions hyperlink. 

f. Select the Edit Importer Permissions hyperlink.

9. In the Authorized Tab Access section:

g. In the CBP Forms row, select the No Access or Full Access radio button.

NOTE: Full Access allows the user to view and respond to CBP Forms in the 
ACE Forms Application. No Access prevents access to CBP Forms. Read Only 
Access is NOT available for CBP Forms.  

h. Select Continue.
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10. The Permission column displays the updated settings. Select the Save button.

Topic 4: Access the ACE Forms Application Through Modernized ACE for the steps to 
locate your pending CBP form(s). 

11. In the Forms Search Results pane, in the Form Type column, select a Form 28 hyperlink.

12. In the Details for Entry # pane, select Respond from the Action drop-down menu.

NOTE: Select Generate PDF from the Action drop-down menu to create a PDF of 
the form.  

4. Complete this step if you have not provided a response to CBP. Skip to step 5 if you already
provided the requested information to CBP.

In the Respond CBP Form 28 dialog box:

a. In the Trade Reply: field, type a reply.
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b. In the Name* field, type your name.

c. In the Title* field, type your title.

d. In the Telephone* field, type your
telephone number.

e. In the Email* field, type your email address.

5. Complete this step to indicate you have already provided the requested information to CBP.
Skip this step if you completed the previous step 4.

In the Respond CBP Form 28 dialog box:

a. In the Name* field, type your name.

b. In the Title* field, type your title.

c. In the Telephone* field, type your telephone number.

d. In the Email* field, type your email address.

e. In the shaded box, in the Port field, type
your port code.

f. In the Date Information Furnished
field, select the Calendar icon, and
select a date.

6. Select the Add Attachment button, if
appropriate.

a. Select the file to attach.

b. Select the Open button. The file name displays beside the Upload Document To DIS
button.

c. Select the Upload Document To DIS button. The uploaded file displays in the
attachment list.
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7. Select the Save and Send button.
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TOPIC 6: RESPOND TO CBP FORM 29: NOTICE OF ACTION

INTRODUCTION 

You can review and respond to a Form 29 in the CBP Forms application. 

COMPLETE A FORM 29 RESPONSE 

1. Access CBP Forms.

2. If needed, refer to Topic 3: TAOs – Authorize Access to CBP Forms

3. Introduction

In addition to granting access to the Mode of Communication hyperlink, the TAO must set CBP Forms 

permissions for PTAOs and authorized trade account users.  

The ACE Forms application allows authorized users to receive and respond to U.S. Customs and Border 

Protection (CBP) forms and requests: 

• CBP Form 28: Request for Information

• CBP Form 29: Notice of Action

• CBP Form 4647: Notice to Mark/Notice to Re-Deliver

• CBP Form 6051D: Notice of Detention

• CBP Documents Required Notifications

You must complete the following actions to receive, review, and respond to CBP forms in the ACE Forms 

application: 

5. The account Mode of Communication must be set to Portal.

6. The TAO must authorize access to CBP Forms for PTAOs and/or other trade account users as needed.

Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can 

receive, view, search and respond to CBP Forms through the ACE Forms application. 
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NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required 

to respond through the ACE Forms application. They may submit responses through the ACE Forms application 

or to CBP at the port of entry where the entry summary is filed. 
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SET CBP FORMS PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS 

4. Select the Tools tab.

5. In the Task Selector pane, select the User Access hyperlink.

6. In the User Access pane, in the Last Name column, select the last name hyperlink of the
user to edit.

7. In the Account User Information section:

d. Edit the User Role and/or Access To Top Account options if needed.

e. Select the Continue button to view the current access for the user.
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8. In the Single Sign-on Partner Access section:

f. To edit importer permissions, select the Importer sub-tab.

NOTE: To edit broker permissions, in the Broker sub-tab, select the Edit Broker
Permissions hyperlink. 

g. Select the Edit Importer Permissions hyperlink.

9. In the Authorized Tab Access section:

h. In the CBP Forms row, select the No Access or Full Access radio button.

NOTE: Full Access allows the user to view and respond to CBP Forms in the 
ACE Forms Application. No Access prevents access to CBP Forms. Read Only 
Access is NOT available for CBP Forms.  

i. Select Continue.
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10. The Permission column displays the updated settings. Select the Save button.

Topic 4: Access the ACE Forms Application Through Modernized ACE for the steps to 
locate your pending CBP form(s).  

11. In the Forms Search Results pane, in the Form Type column, select a form 29 hyperlink.

12. In the Details for Entry # pane, select
Respond from the Action drop-down
menu.

NOTE: Select Generate PDF 
from the Action drop-down 
menu to create a PDF.  

13. Complete this step if you have not provided a response to CBP. Skip to step 5 if you already
provided the requested information to CBP.

In the Respond CBP Form 29 dialog box:

a. In the Trade Reply: field, type a reply.

b. In the Name* field, type your name.

c. In the Title* field, type your title.

d. In the Telephone* field, type your telephone number.

e. In the Email* field, type your email address.

14. Select the Add Attachment button, if appropriate.

a. Select the file to attach.

b. Select the Open button. The file name displays beside the Upload Document To DIS
button.
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c. Select the Upload Document To DIS button. The uploaded file displays in the
attachment list.

15. Select the Save and Send button.
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TOPIC 7: RESPOND TO CBP FORM 4647: NOTICE TO MARK/NOTICE TO RE-DELIVER 

INTRODUCTION 

Use CBP Forms to complete the notice to mark and/or redeliver details for Form 4647. 

COMPLETE A FORM 4647 RESPONSE 

1. Access CBP Forms.

2. If needed, refer to Topic 3: TAOs – Authorize Access to CBP Forms

3. Introduction

In addition to granting access to the Mode of Communication hyperlink, the TAO must set CBP Forms 

permissions for PTAOs and authorized trade account users.  

The ACE Forms application allows authorized users to receive and respond to U.S. Customs and Border 

Protection (CBP) forms and requests: 

• CBP Form 28: Request for Information

• CBP Form 29: Notice of Action

• CBP Form 4647: Notice to Mark/Notice to Re-Deliver

• CBP Form 6051D: Notice of Detention

• CBP Documents Required Notifications

You must complete the following actions to receive, review, and respond to CBP forms in the ACE Forms 

application: 

7. The account Mode of Communication must be set to Portal.

8. The TAO must authorize access to CBP Forms for PTAOs and/or other trade account users as needed.

Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can 

receive, view, search and respond to CBP Forms through the ACE Forms application. 
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NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required 

to respond through the ACE Forms application. They may submit responses through the ACE Forms application 

or to CBP at the port of entry where the entry summary is filed. 
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SET CBP FORMS PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS 

4. Select the Tools tab.

5. In the Task Selector pane, select the User Access hyperlink.

6. In the User Access pane, in the Last Name column, select the last name hyperlink of the
user to edit.

7. In the Account User Information section:

d. Edit the User Role and/or Access To Top Account options if needed.

e. Select the Continue button to view the current access for the user.
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8. In the Single Sign-on Partner Access section:

f. To edit importer permissions, select the Importer sub-tab.

NOTE: To edit broker permissions, in the Broker sub-tab, select the Edit Broker
Permissions hyperlink. 

g. Select the Edit Importer Permissions hyperlink.

9. In the Authorized Tab Access section:

h. In the CBP Forms row, select the No Access or Full Access radio button.

NOTE: Full Access allows the user to view and respond to CBP Forms in the 
ACE Forms Application. No Access prevents access to CBP Forms. Read Only 
Access is NOT available for CBP Forms.  

i. Select Continue.
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10. The Permission column displays the updated settings. Select the Save button.

Topic 4: Access the ACE Forms Application Through Modernized ACE for the steps to 
locate your pending CBP form(s). 

11. In the Forms Search Results pane, in the Form Type column, select a form 4647
hyperlink.

12. In the Details for Entry # pane, select Respond from the Action drop-down menu.

NOTE: Select Generate PDF from the Action drop-down menu to create a PDF of 
the form.  

13. Skip to step 5 if the merchandise is not going to be exported or destroyed.

If the merchandise is to be exported or destroyed, complete the following steps in the
Respond to CBP Form 4647: Notice to Mark and/or Notice to Redeliver dialog box, in
the Importer Certification section:

a. In the Merchandise To be: field, select either the Exported radio button or Destroyed
under CBP supervision in lieu of marking or other required corrective measures
radio button.

b. In the Place field, type the place where the merchandise was either exported or
destroyed.

c. In the Date field, select the Calendar icon and select the date the merchandise was
either exported or destroyed.

d. In the Time field, type the time the merchandise was either exported or destroyed.
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14. In the Respond to CBP Form 4647: Notice to Mark and/or Notice to Redeliver dialog
box, in the Importer Certification section:

NOTE: This step is for merchandise that is not going to be exported or 
destroyed.  

a. Select the radio button in the I certify that all merchandise has been marked to
indicate the country of origin as required by 19 U.S.C. 1304 or otherwise brought
into compliance with statute(s) or regulation(s) field.

b. In the Sample is, is not submitted herein field, select a radio button.

c. In the Place field, type the place where the merchandise is being held.

d. In the Telephone field, type your telephone number.

15. In the I (we) guarantee the payment of all expenses incident to the above action
section:

a. In the Name field, type your name.

b. In the Title field, type your title.

c. In the Telephone field, type your
telephone number.

d. In the Email field, type your email address.

16. Select the Add Attachment button, if appropriate.

a. Select the file to attach.
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b. Select the Open button. The file name displays beside the Upload Document To DIS
button.

c. Select the Upload Document To DIS button. The uploaded file displays in the
attachment list.

17. Select the Save and Send button.
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TOPIC 8: RESPOND TO CBP FORM 6051D 

INTRODUCTION 

Importers with ACE Portal access can respond to a CBP Form 6051D via the ACE Forms application. 

NOTE: Required fields are indicated by a red asterisk. 

COMPLETE A FORM 6051D RESPONSE 

1. Access CBP Forms.

2. If needed, refer to Topic 3: TAOs – Authorize Access to CBP Forms

3. Introduction

In addition to granting access to the Mode of Communication hyperlink, the TAO must set CBP Forms 

permissions for PTAOs and authorized trade account users.  

The ACE Forms application allows authorized users to receive and respond to U.S. Customs and Border 

Protection (CBP) forms and requests: 

• CBP Form 28: Request for Information

• CBP Form 29: Notice of Action

• CBP Form 4647: Notice to Mark/Notice to Re-Deliver

• CBP Form 6051D: Notice of Detention

• CBP Documents Required Notifications

You must complete the following actions to receive, review, and respond to CBP forms in the ACE Forms 

application: 

9. The account Mode of Communication must be set to Portal.

10. The TAO must authorize access to CBP Forms for PTAOs and/or other trade account users as needed.
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Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can 

receive, view, search and respond to CBP Forms through the ACE Forms application. 

NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required 

to respond through the ACE Forms application. They may submit responses through the ACE Forms application 

or to CBP at the port of entry where the entry summary is filed. 
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SET CBP FORMS PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS 

4. Select the Tools tab.

5. In the Task Selector pane, select the User Access hyperlink.

6. In the User Access pane, in the Last Name column, select the last name hyperlink of the
user to edit.

7. In the Account User Information section:

d. Edit the User Role and/or Access To Top Account options if needed.

e. Select the Continue button to view the current access for the user.
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8. In the Single Sign-on Partner Access section:

f. To edit importer permissions, select the Importer sub-tab.

NOTE: To edit broker permissions, in the Broker sub-tab, select the Edit Broker
Permissions hyperlink. 

g. Select the Edit Importer Permissions hyperlink.

9. In the Authorized Tab Access section:

h. In the CBP Forms row, select the No Access or Full Access radio button.

NOTE: Full Access allows the user to view and respond to CBP Forms in the 
ACE Forms Application. No Access prevents access to CBP Forms. Read Only 
Access is NOT available for CBP Forms.  

i. Select Continue.



Quick Reference Guide 
CBP Modernized Forms 

January 2024 
Publication No. 3095-0323  

Topic 8: Respond to CBP Form 6051D 

10. The Permission column displays the updated settings. Select the Save button.

Topic 4: Access the ACE Forms Application Through Modernized ACE for the steps to 
locate your pending CBP form(s). 

11. In the Forms Search Results pane, in the Form Type column, select a CBP Form 6051D
hyperlink.

12. In the Details for Entry Number pane, in the Action dropdown, select Respond.

13. In the Form 6051D Response pane, enter the required information for Name, Telephone,
Title, and Email.
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14. Certify that the information provided is correct by reading the certification statement and
checking the box.

15. Certify that there are no further supporting documents by reading the certification statement
and checking the box.

IMPORTANT: Users will have the ability to respond to the 6051D form as many 
times as they desire before the due date, provided they do not certify “no further 
supporting documents are forthcoming”. Once a user certifies there are no further 
supporting documents forthcoming, or the due date has passed, they will not be 
able to respond to the form.  

16. Select the Add Attachment button to add supporting documents.

IMPORTANT: All uploaded documentation will be stored in the ACE Document 
Image System (DIS).  Documents submitted via DIS should be named to easily 
identify the document.  Documents submitted for Withhold Release Order 
(WRO)/UFLPA detentions should be named based on the production process 
stage or the producer name. For example, documents submitted for solar cell 
producer X or for solar cells stage should be named as solar cell producer X: 
invoice; solar cell producer X: contract; solar producer X: delivery tickets; solar cell 
producer Y: invoice; solar cell producer Y: contract, etc... 

The maximum individual file size that can be submitted DIS is 10 MB. 

NOTE: Successfully added attachments display in the table below the Add 
Attachment button. Navigate the table, if required, by using the Filter field or the 
navigation buttons.  
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17. Select the Save button.

The Details for Entry Number pane displays, and the Status will be updated to Response 
Received. 
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TOPIC 9: RESPOND TO DOCUMENTS REQUIRED NOTICE 

INTRODUCTION 

A CBP employee can initiate an electronic post summary request for additional documentation to the filer. 

You can respond to documents required notifications through the ACE Forms application. 

RESPOND TO A DOCUMENTS REQUIRED MESSAGE 

1. Access CBP Forms.

2. If needed, refer to Topic 3: TAOs – Authorize Access to CBP Forms

3. Introduction

In addition to granting access to the Mode of Communication hyperlink, the TAO must set CBP Forms 

permissions for PTAOs and authorized trade account users.  

The ACE Forms application allows authorized users to receive and respond to U.S. Customs and Border 

Protection (CBP) forms and requests: 

• CBP Form 28: Request for Information

• CBP Form 29: Notice of Action

• CBP Form 4647: Notice to Mark/Notice to Re-Deliver

• CBP Form 6051D: Notice of Detention

• CBP Documents Required Notifications

You must complete the following actions to receive, review, and respond to CBP forms in the ACE Forms 

application: 

11. The account Mode of Communication must be set to Portal.

12. The TAO must authorize access to CBP Forms for PTAOs and/or other trade account users as needed.
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Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can 

receive, view, search and respond to CBP Forms through the ACE Forms application. 

NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required 

to respond through the ACE Forms application. They may submit responses through the ACE Forms application 

or to CBP at the port of entry where the entry summary is filed. 
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SET CBP FORMS PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS 

4. Select the Tools tab.

5. In the Task Selector pane, select the User Access hyperlink.

6. In the User Access pane, in the Last Name column, select the last name hyperlink of the
user to edit.

7. In the Account User Information section:

j. Edit the User Role and/or Access To Top Account options if needed.

k. Select the Continue button to view the current access for the user.
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8. In the Single Sign-on Partner Access section:

l. To edit importer permissions, select the Importer sub-tab.

NOTE: To edit broker permissions, in the Broker sub-tab, select the Edit Broker
Permissions hyperlink. 

m. Select the Edit Importer Permissions hyperlink.

9. In the Authorized Tab Access section:

n. In the CBP Forms row, select the No Access or Full Access radio button.

NOTE: Full Access allows the user to view and respond to CBP Forms in the 
ACE Forms Application. No Access prevents access to CBP Forms. Read Only 
Access is NOT available for CBP Forms.  

o. Select Continue.
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10. The Permission column displays the updated settings. Select the Save button.

Topic 4: Access the ACE Forms Application Through Modernized ACE for the steps to 
locate your pending CBP form(s).  

11. In the Forms Search Results pane, in the Form Type column, select a Docs Required
hyperlink.

12. In the Details for Entry # pane, select Respond from the Action drop-down menu.

13. In the Send Response dialog box:

a. In the Name field, type your
name.

b. In the Telephone field, type
your telephone number.

c. In the Title field, type your title.

d. In the Email field, type your
email address.
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14. Select the Add Attachment button.

a. Select the file to attach.

b. Select the Open button.

The file name displays beside the Upload Document To DIS button.

c. Select the Upload Document To DIS button.

The uploaded file displays in the attachment list.

15. Select the Save and Send button.
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TOPIC 10: FORMAT ATTACHMENTS FOR UPLOAD

INTRODUCTION 

The CBP preferred file types for document submission include: 

- PDF

- GIF

- PNG

- JPG

- JPEG

- XLS, XLSX (for specific programs such as CBMA)

There are additional file types that may be submitted and accepted for upload. CBP recommends the above listed 

types for image quality and ease of upload.   

Individual attachment size cannot exceed 10 MB. 
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	TOPIC 1: SET THE MODE OF COMMUNICATION 
	INTRODUCTION 
	Setting the Mode of Communication is an important step in ensuring that Trade Account Owners (TAOs), Proxy Trade Account Owners (PTAOs), and trade account users can receive, review, and respond to CBP forms via the ACE Forms application.  
	Mode of Communication applies to how the trade receives and responds to CBP forms. The modes of communication are Mail (via U.S. Postal Service) and Portal (via the ACE Forms application). If a Mode of Communication is not set, the default communication for CBP forms is U.S. Postal Service mail.  
	TAOs must select the Mode of Communication for CBP Forms. 
	Figure
	NOTE: TAOs may also authorize PTAOs and other trade account users to view and/or modify Mode of Communication settings. Refer to  for steps to edit Mode of Communication user permissions. 
	Topic 2: TAOs – Authorize Access to Mode of Communication
	Topic 2: TAOs – Authorize Access to Mode of Communication


	You can select the Mode of Communication at either the top account level or the sub-account (importer of record) level. 
	If you select the mode at the top account level, and select Yes in response to the Apply these settings to all accounts under this top account question, all forms pertaining to the top account and any of the sub-accounts will be sent by the selected Mode of Communication.  
	 
	Figure
	If you select the Mode of Communication at the sub-account level, then that mode will only apply to the selected sub-account. 
	L
	LI
	Lbl
	SET THE MODE OF COMMUNICATION 

	1.
	1.
	 Select the Accounts tab. 


	 
	Figure
	2.
	2.
	2.
	 In the Task Selector pane:  
	Figure


	a.
	a.
	 In the Select Account Type section, in the View drop-down menu, select Importer. 

	b.
	b.
	 Select the Go button. 

	c.
	c.
	 In the Select Task section, select the Mode of Communication hyperlink. 


	NOTE: To set the Mode of Communication at the sub-account level, you will need to select the sub-account before selecting the Mode of Communication hyperlink. 
	Figure
	3.
	3.
	3.
	 In the Mode of Communication Settings pane, select the Edit button. 


	 
	Figure
	4.
	4.
	4.
	 In the Mode of Communication (Post-Release) section: 


	 
	Figure
	a.
	a.
	a.
	 Select a Modes checkbox(es) to indicate your communication preference. 


	IMPORTANT: You can select both Mail and Portal as your Mode of Communication. You will then be able to view and respond to CBP forms via the ACE Forms application as well as receive a mailed copy. Selecting Portal does not obligate you to respond via the ACE Forms application. 
	Figure
	b.
	b.
	b.
	 Select the Yes or No radio button option to indicate if settings should apply to all accounts. 

	5.
	5.
	 Select the Save button to confirm the settings. 


	NOTE: You may change the Mode of Communication settings at any time by completing the above steps 1-3 to access the Edit button, and then completing steps 4 and 5 to modify and save changes.  
	Figure
	TOPIC 2: TAOS – AUTHORIZE ACCESS TO MODE OF COMMUNICATION 
	INTRODUCTION 
	TAOs may authorize PTAOs and other trade account users to view and/or modify Mode of Communication settings. 
	Figure
	IMPORTANT: Changes made by authorized PTAOs and trade account users apply at the account level and for all users. Changes are not applied as individual user settings for the PTAO or trade account user making the changes. 
	L
	LI
	Lbl
	TAOS – SET MODE OF COMMUNICATION PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS  

	1.
	1.
	 Select the Tools tab. 
	Figure



	 
	 
	2.
	2.
	2.
	 In the Task Selector pane, select the User Access hyperlink. 


	 
	Figure
	3.
	3.
	3.
	 In the User Access pane, in the Last Name column, select the last name hyperlink of the user to edit.  


	 
	Figure
	4.
	4.
	4.
	 In the Account User Information section:  

	a.
	a.
	 Edit the User Role and/or Access to Top Account options as needed.  

	b.
	b.
	 Select the Continue button.  


	I  
	Figure
	5.
	5.
	5.
	 In the Single Sign-on Partner Access section:  

	a.
	a.
	 Select the Importer sub-tab to change the importer account type permissions. 

	b.
	b.
	 Select the Edit Importer Permissions hyperlink. 


	 
	Figure
	6.
	6.
	6.
	 In the Authorized Tab Access section:  
	Figure


	a.
	a.
	 In the Mode of Communication row, select the No Access, Read Only Access, or Full Access radio button. 
	Figure



	NOTE: Full Access allows the user to create, maintain and display the Mode of Communication. Read Only Access allows the user to view the Mode of Communication. No Access prevents access to the Mode of Communication hyperlink. 
	b.
	b.
	b.
	 Select Continue. 

	7.
	7.
	 The Permission column displays the updated settings. Select the Save button. 


	 
	Figure
	TOPIC 3: TAOS – AUTHORIZE ACCESS TO CBP FORMS 
	INTRODUCTION 
	In addition to granting access to the Mode of Communication hyperlink, the TAO must set CBP Forms permissions for PTAOs and authorized trade account users.  
	The ACE Forms application allows authorized users to receive and respond to U.S. Customs and Border Protection (CBP) forms and requests: 
	•
	•
	•
	 CBP Form 28: Request for Information  

	•
	•
	 CBP Form 29: Notice of Action 

	•
	•
	 CBP Form 4647: Notice to Mark/Notice to Re-Deliver 

	•
	•
	 CBP Form 6051D: Notice of Detention  

	•
	•
	 CBP Documents Required Notifications 


	You must complete the following actions to receive, review, and respond to CBP forms in the ACE Forms application: 
	1.
	1.
	1.
	 The account Mode of Communication must be set to Portal. 


	 
	Figure
	2.
	2.
	2.
	 The TAO must authorize access to CBP Forms for PTAOs and/or other trade account users as needed. 


	 
	Figure
	Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can receive, view, search and respond to CBP Forms through the ACE Forms application. 
	NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required to respond through the ACE Forms application. They may submit responses through the ACE Forms application or to CBP at the port of entry where the entry summary is filed. 
	Figure
	  
	L
	LI
	Lbl
	SET CBP FORMS PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS 

	1.
	1.
	 Select the Tools tab. 


	 
	Figure
	2.
	2.
	2.
	 In the Task Selector pane, select the User Access hyperlink.  


	 
	Figure
	3.
	3.
	3.
	 In the User Access pane, in the Last Name column, select the last name hyperlink of the user to edit.  


	 
	Figure
	4.
	4.
	4.
	 In the Account User Information section:  

	a.
	a.
	 Edit the User Role and/or Access To Top Account options if needed.  

	b.
	b.
	 Select the Continue button to view the current access for the user.  


	 
	Figure
	5.
	5.
	5.
	 In the Single Sign-on Partner Access section:  

	a.
	a.
	 To edit importer permissions, select the Importer sub-tab.  
	Figure



	NOTE: To edit broker permissions, in the Broker sub-tab, select the Edit Broker Permissions hyperlink. 
	b.
	b.
	b.
	 Select the Edit Importer Permissions hyperlink. 


	 
	Figure
	6.
	6.
	6.
	 In the Authorized Tab Access section:  

	a.
	a.
	 In the CBP Forms row, select the No Access or Full Access radio button. 


	NOTE: Full Access allows the user to view and respond to CBP Forms in the ACE Forms Application. No Access prevents access to CBP Forms. Read Only Access is NOT available for CBP Forms.  
	Figure
	b.
	b.
	b.
	 Select Continue.  


	 
	Figure
	  
	7.
	7.
	7.
	 The Permission column displays the updated settings. Select the Save button. 


	 
	Figure
	TOPIC 4: ACCESS THE ACE FORMS APPLICATION THROUGH MODERNIZED ACE 
	INTRODUCTION 
	The Modernized ACE Forms application allows users to view and manage electronic versions of CBP Forms. 
	A key upgrade in CBP Forms is the Courtesy Copy feature:  
	When CBP issues a form, brokers now have the option to receive an electronic courtesy copy of the form via email, using the primary point of contact’s email address associated with a broker’s ACE Portal account (sub-account level).  
	To receive the electronic courtesy copy, the Mode of Communication must be set to Portal and/or Mail in the importer’s ACE Portal Account and the broker’s ACE Portal account.  
	For assistance with access and login to the Modernized ACE Portal, refer to the  QRG. 
	Modernized ACE Portal – Create Account and Login
	Modernized ACE Portal – Create Account and Login


	L
	LI
	Lbl
	ACCESS FORMS THROUGH MODERNIZED ACE  

	1.
	1.
	 Login to the ACE Modernized Portal.  

	2.
	2.
	 Select the Accounts tab. 


	 
	Figure
	3.
	3.
	3.
	 Select Importer. 


	 
	Figure
	4.
	4.
	4.
	 In the Account Name column, select the importer name hyperlink.  


	 
	Figure
	5.
	5.
	5.
	 In the Importer Account page, select the Forms button.  


	 
	Figure
	The ACE Forms application displays.  
	 
	Figure
	6.
	6.
	6.
	 In the Search Forms pane: 

	a.
	a.
	 In the Entry Number field, type an entry number. 

	b.
	b.
	 Select the Search button. 


	  
	Figure
	Figure
	NOTE: There are two other ways to search for forms requiring a response:  
	Advanced Search hyperlink in the Search Forms pane. 
	 
	Figure
	Pending Response hyperlink in the Trade Hotlist pane. 
	 
	Figure
	Figure
	NOTE: Select the Overdue hyperlink in the Trade Hotlist pane to display the list of overdue forms. Overdue notices are based on the due date of the form. 
	TOPIC 5: RESPOND TO CBP FORM 28: REQUEST FOR INFORMATION  
	INTRODUCTION 
	You can review and respond to a Form 28 in the CBP Forms application.  
	L
	LI
	Lbl
	COMPLETE A FORM 28 RESPONSE 

	1.
	1.
	 Access CBP Forms.  

	2.
	2.
	 If needed, refer to 
	Topic 3: TAOs – Authorize Access to CBP Forms 
	Topic 3: TAOs – Authorize Access to CBP Forms 



	3.
	3.
	 Introduction 
	 Introduction 



	In addition to granting access to the Mode of Communication hyperlink, the TAO must set CBP Forms permissions for PTAOs and authorized trade account users.  
	In addition to granting access to the Mode of Communication hyperlink, the TAO must set CBP Forms permissions for PTAOs and authorized trade account users.  

	The ACE Forms application allows authorized users to receive and respond to U.S. Customs and Border Protection (CBP) forms and requests: 
	The ACE Forms application allows authorized users to receive and respond to U.S. Customs and Border Protection (CBP) forms and requests: 

	•
	•
	•
	 CBP Form 28: Request for Information  
	 CBP Form 28: Request for Information  


	•
	•
	 CBP Form 29: Notice of Action 
	 CBP Form 29: Notice of Action 


	•
	•
	 CBP Form 4647: Notice to Mark/Notice to Re-Deliver 
	 CBP Form 4647: Notice to Mark/Notice to Re-Deliver 


	•
	•
	 CBP Form 6051D: Notice of Detention  
	 CBP Form 6051D: Notice of Detention  


	•
	•
	 CBP Documents Required Notifications 
	 CBP Documents Required Notifications 



	You must complete the following actions to receive, review, and respond to CBP forms in the ACE Forms application: 
	You must complete the following actions to receive, review, and respond to CBP forms in the ACE Forms application: 

	3.
	3.
	3.
	 The account Mode of Communication must be set to Portal. 
	 The account Mode of Communication must be set to Portal. 



	 
	 

	Figure
	4.
	4.
	4.
	 The TAO must authorize access to CBP Forms for PTAOs and/or other trade account users as needed. 
	 The TAO must authorize access to CBP Forms for PTAOs and/or other trade account users as needed. 



	 
	 

	Figure
	Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can receive, view, search and respond to CBP Forms through the ACE Forms application. 
	Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can receive, view, search and respond to CBP Forms through the ACE Forms application. 

	NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required to respond through the ACE Forms application. They may submit responses through the ACE Forms application or to CBP at the port of entry where the entry summary is filed. 
	NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required to respond through the ACE Forms application. They may submit responses through the ACE Forms application or to CBP at the port of entry where the entry summary is filed. 
	NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required to respond through the ACE Forms application. They may submit responses through the ACE Forms application or to CBP at the port of entry where the entry summary is filed. 
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	SET CBP FORMS PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS 
	SET CBP FORMS PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS 
	SET CBP FORMS PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS 



	4.
	4.
	 Select the Tools tab. 
	 Select the Tools tab. 



	 
	 

	Figure
	5.
	5.
	5.
	 In the Task Selector pane, select the User Access hyperlink.  
	 In the Task Selector pane, select the User Access hyperlink.  



	 
	 

	Figure
	6.
	6.
	6.
	 In the User Access pane, in the Last Name column, select the last name hyperlink of the user to edit.  
	 In the User Access pane, in the Last Name column, select the last name hyperlink of the user to edit.  



	 
	 

	Figure
	7.
	7.
	7.
	 In the Account User Information section:  
	 In the Account User Information section:  


	c.
	c.
	 Edit the User Role and/or Access To Top Account options if needed.  
	 Edit the User Role and/or Access To Top Account options if needed.  


	d.
	d.
	 Select the Continue button to view the current access for the user.  
	 Select the Continue button to view the current access for the user.  



	 
	 
	 


	Figure
	8.
	8.
	8.
	 In the Single Sign-on Partner Access section:  
	 In the Single Sign-on Partner Access section:  


	e.
	e.
	 To edit importer permissions, select the Importer sub-tab.  
	 To edit importer permissions, select the Importer sub-tab.  



	NOTE: To edit broker permissions, in the Broker sub-tab, select the Edit Broker Permissions hyperlink. 
	NOTE: To edit broker permissions, in the Broker sub-tab, select the Edit Broker Permissions hyperlink. 

	f.
	f.
	f.
	 Select the Edit Importer Permissions hyperlink. 
	 Select the Edit Importer Permissions hyperlink. 



	 
	 

	Figure
	9.
	9.
	9.
	 In the Authorized Tab Access section:  
	 In the Authorized Tab Access section:  


	g.
	g.
	 In the CBP Forms row, select the No Access or Full Access radio button. 
	 In the CBP Forms row, select the No Access or Full Access radio button. 



	NOTE: Full Access allows the user to view and respond to CBP Forms in the ACE Forms Application. No Access prevents access to CBP Forms. Read Only Access is NOT available for CBP Forms.  
	NOTE: Full Access allows the user to view and respond to CBP Forms in the ACE Forms Application. No Access prevents access to CBP Forms. Read Only Access is NOT available for CBP Forms.  

	h.
	h.
	h.
	 Select Continue.  
	 Select Continue.  



	 
	 

	Figure
	  
	  

	10.
	10.
	10.
	 The Permission column displays the updated settings. Select the Save button. 
	 The Permission column displays the updated settings. Select the Save button. 
	 The Permission column displays the updated settings. Select the Save button. 




	 
	 

	Figure
	 for the steps to locate your pending CBP form(s). 
	Topic 4: Access the ACE Forms Application Through Modernized ACE

	11.
	11.
	11.
	 In the Forms Search Results pane, in the Form Type column, select a Form 28 hyperlink.  

	12.
	12.
	 In the Details for Entry # pane, select Respond from the Action drop-down menu. 


	 
	Figure
	NOTE: Select Generate PDF from the Action drop-down menu to create a PDF of the form.  
	Figure
	4.
	4.
	4.
	 Complete this step if you have not provided a response to CBP. Skip to step 5 if you already provided the requested information to CBP.  
	a.
	a.
	a.
	 In the Trade Reply: field, type a reply.  
	Figure


	b.
	b.
	 In the Name* field, type your name.  
	Figure


	c.
	c.
	 In the Title* field, type your title. 

	d.
	d.
	 In the Telephone* field, type your 

	telephone number
	telephone number
	. 

	e.
	e.
	 In the Email* field, type your email address. 





	In the Respond CBP Form 28 dialog box:  
	 
	5.
	5.
	5.
	 Complete this step to indicate you have already provided the requested information to CBP. Skip this step if you completed the previous step 4. 


	In the Respond CBP Form 28 dialog box:  
	a.
	a.
	a.
	 In the Name* field, type your name. 

	b.
	b.
	 In the Title* field, type your title. 

	c.
	c.
	 In the Telephone* field, type your telephone number. 

	d.
	d.
	 In the Email* field, type your email address. 
	Figure


	e.
	e.
	 In the shaded box, in the Port field, type your port code. 

	f.
	f.
	 In the Date Information Furnished field, select the Calendar icon, and select a date.  

	6.
	6.
	 Select the Add Attachment button, if appropriate. 

	 
	 
	LBody
	Figure


	a.
	a.
	 Select the file to attach.  

	b.
	b.
	 Select the Open button. The file name displays beside the Upload Document To DIS button. 


	 
	Figure
	c.
	c.
	c.
	 Select the Upload Document To DIS button. The uploaded file displays in the attachment list.  


	 
	Figure
	7.
	7.
	7.
	 Select the Save and Send button. 


	TOPIC 6: RESPOND TO CBP FORM 29: NOTICE OF ACTION  
	INTRODUCTION 
	You can review and respond to a Form 29 in the CBP Forms application.  
	L
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	COMPLETE A FORM 29 RESPONSE 

	1.
	1.
	 Access CBP Forms.  

	2.
	2.
	 If needed, refer to 
	Topic 3: TAOs – Authorize Access to CBP Forms 
	Topic 3: TAOs – Authorize Access to CBP Forms 



	3.
	3.
	 Introduction 
	 Introduction 



	In addition to granting access to the Mode of Communication hyperlink, the TAO must set CBP Forms permissions for PTAOs and authorized trade account users.  
	In addition to granting access to the Mode of Communication hyperlink, the TAO must set CBP Forms permissions for PTAOs and authorized trade account users.  

	The ACE Forms application allows authorized users to receive and respond to U.S. Customs and Border Protection (CBP) forms and requests: 
	The ACE Forms application allows authorized users to receive and respond to U.S. Customs and Border Protection (CBP) forms and requests: 

	•
	•
	•
	 CBP Form 28: Request for Information  
	 CBP Form 28: Request for Information  


	•
	•
	 CBP Form 29: Notice of Action 
	 CBP Form 29: Notice of Action 


	•
	•
	 CBP Form 4647: Notice to Mark/Notice to Re-Deliver 
	 CBP Form 4647: Notice to Mark/Notice to Re-Deliver 


	•
	•
	 CBP Form 6051D: Notice of Detention  
	 CBP Form 6051D: Notice of Detention  


	•
	•
	 CBP Documents Required Notifications 
	 CBP Documents Required Notifications 



	You must complete the following actions to receive, review, and respond to CBP forms in the ACE Forms application: 
	You must complete the following actions to receive, review, and respond to CBP forms in the ACE Forms application: 

	5.
	5.
	5.
	 The account Mode of Communication must be set to Portal. 
	 The account Mode of Communication must be set to Portal. 
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	6.
	6.
	6.
	 The TAO must authorize access to CBP Forms for PTAOs and/or other trade account users as needed. 
	 The TAO must authorize access to CBP Forms for PTAOs and/or other trade account users as needed. 



	 
	 

	Figure
	Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can receive, view, search and respond to CBP Forms through the ACE Forms application. 
	Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can receive, view, search and respond to CBP Forms through the ACE Forms application. 

	NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required to respond through the ACE Forms application. They may submit responses through the ACE Forms application or to CBP at the port of entry where the entry summary is filed. 
	NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required to respond through the ACE Forms application. They may submit responses through the ACE Forms application or to CBP at the port of entry where the entry summary is filed. 
	NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required to respond through the ACE Forms application. They may submit responses through the ACE Forms application or to CBP at the port of entry where the entry summary is filed. 
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	SET CBP FORMS PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS 
	SET CBP FORMS PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS 



	4.
	4.
	 Select the Tools tab. 
	 Select the Tools tab. 
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	5.
	5.
	5.
	 In the Task Selector pane, select the User Access hyperlink.  
	 In the Task Selector pane, select the User Access hyperlink.  
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	6.
	6.
	6.
	 In the User Access pane, in the Last Name column, select the last name hyperlink of the user to edit.  
	 In the User Access pane, in the Last Name column, select the last name hyperlink of the user to edit.  
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	7.
	7.
	7.
	 In the Account User Information section:  
	 In the Account User Information section:  


	d.
	d.
	 Edit the User Role and/or Access To Top Account options if needed.  
	 Edit the User Role and/or Access To Top Account options if needed.  


	e.
	e.
	 Select the Continue button to view the current access for the user.  
	 Select the Continue button to view the current access for the user.  
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	8.
	8.
	8.
	 In the Single Sign-on Partner Access section:  
	 In the Single Sign-on Partner Access section:  


	f.
	f.
	 To edit importer permissions, select the Importer sub-tab.  
	 To edit importer permissions, select the Importer sub-tab.  



	NOTE: To edit broker permissions, in the Broker sub-tab, select the Edit Broker Permissions hyperlink. 
	NOTE: To edit broker permissions, in the Broker sub-tab, select the Edit Broker Permissions hyperlink. 

	g.
	g.
	g.
	 Select the Edit Importer Permissions hyperlink. 
	 Select the Edit Importer Permissions hyperlink. 
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	9.
	9.
	9.
	 In the Authorized Tab Access section:  
	 In the Authorized Tab Access section:  


	h.
	h.
	 In the CBP Forms row, select the No Access or Full Access radio button. 
	 In the CBP Forms row, select the No Access or Full Access radio button. 



	NOTE: Full Access allows the user to view and respond to CBP Forms in the ACE Forms Application. No Access prevents access to CBP Forms. Read Only Access is NOT available for CBP Forms.  
	NOTE: Full Access allows the user to view and respond to CBP Forms in the ACE Forms Application. No Access prevents access to CBP Forms. Read Only Access is NOT available for CBP Forms.  
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	i.
	 Select Continue.  
	 Select Continue.  
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	10.
	10.
	10.
	 The Permission column displays the updated settings. Select the Save button. 
	 The Permission column displays the updated settings. Select the Save button. 
	 The Permission column displays the updated settings. Select the Save button. 




	 
	 

	Figure
	 for the steps to locate your pending CBP form(s).  
	Topic 4: Access the ACE Forms Application Through Modernized ACE

	11.
	11.
	11.
	 In the Forms Search Results pane, in the Form Type column, select a form 29 hyperlink. 

	12.
	12.
	 In the Details for Entry # pane, select Respond from the Action drop-down menu. 
	Figure
	Figure



	NOTE: Select Generate PDF from the Action drop-down menu to create a PDF.  
	13.
	13.
	13.
	 Complete this step if you have not provided a response to CBP. Skip to step 5 if you already provided the requested information to CBP. 
	a.
	a.
	a.
	 In the Trade Reply: field, type a reply. 

	b.
	b.
	 In the Name* field, type your name. 

	c.
	c.
	 In the Title* field, type your title. 

	d.
	d.
	 In the Telephone* field, type your telephone number. 

	e.
	e.
	 In the Email* field, type your email address. 





	In the Respond CBP Form 29 dialog box: 
	14.
	14.
	14.
	 Select the Add Attachment button, if appropriate.  
	Figure


	a.
	a.
	 Select the file to attach.  

	b.
	b.
	 Select the Open button. The file name displays beside the Upload Document To DIS button. 
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	c.
	c.
	c.
	 Select the Upload Document To DIS button. The uploaded file displays in the attachment list.  
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	15.
	15.
	15.
	 Select the Save and Send button. 
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	TOPIC 7: RESPOND TO CBP FORM 4647: NOTICE TO MARK/NOTICE TO RE-DELIVER 
	INTRODUCTION 
	Use CBP Forms to complete the notice to mark and/or redeliver details for Form 4647.  
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	COMPLETE A FORM 4647 RESPONSE 

	1.
	1.
	 Access CBP Forms.  

	2.
	2.
	 If needed, refer to 
	Topic 3: TAOs – Authorize Access to CBP Forms 
	Topic 3: TAOs – Authorize Access to CBP Forms 
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	 Introduction 
	 Introduction 



	In addition to granting access to the Mode of Communication hyperlink, the TAO must set CBP Forms permissions for PTAOs and authorized trade account users.  
	In addition to granting access to the Mode of Communication hyperlink, the TAO must set CBP Forms permissions for PTAOs and authorized trade account users.  

	The ACE Forms application allows authorized users to receive and respond to U.S. Customs and Border Protection (CBP) forms and requests: 
	The ACE Forms application allows authorized users to receive and respond to U.S. Customs and Border Protection (CBP) forms and requests: 

	•
	•
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	 CBP Form 28: Request for Information  
	 CBP Form 28: Request for Information  
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	 CBP Form 29: Notice of Action 
	 CBP Form 29: Notice of Action 
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	 CBP Form 4647: Notice to Mark/Notice to Re-Deliver 
	 CBP Form 4647: Notice to Mark/Notice to Re-Deliver 


	•
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	 CBP Form 6051D: Notice of Detention  
	 CBP Form 6051D: Notice of Detention  


	•
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	 CBP Documents Required Notifications 
	 CBP Documents Required Notifications 



	You must complete the following actions to receive, review, and respond to CBP forms in the ACE Forms application: 
	You must complete the following actions to receive, review, and respond to CBP forms in the ACE Forms application: 

	7.
	7.
	7.
	 The account Mode of Communication must be set to Portal. 
	 The account Mode of Communication must be set to Portal. 
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	8.
	8.
	8.
	 The TAO must authorize access to CBP Forms for PTAOs and/or other trade account users as needed. 
	 The TAO must authorize access to CBP Forms for PTAOs and/or other trade account users as needed. 



	 
	 

	Figure
	Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can receive, view, search and respond to CBP Forms through the ACE Forms application. 
	Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can receive, view, search and respond to CBP Forms through the ACE Forms application. 

	NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required to respond through the ACE Forms application. They may submit responses through the ACE Forms application or to CBP at the port of entry where the entry summary is filed. 
	NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required to respond through the ACE Forms application. They may submit responses through the ACE Forms application or to CBP at the port of entry where the entry summary is filed. 
	NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required to respond through the ACE Forms application. They may submit responses through the ACE Forms application or to CBP at the port of entry where the entry summary is filed. 
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	SET CBP FORMS PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS 
	SET CBP FORMS PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS 



	4.
	4.
	 Select the Tools tab. 
	 Select the Tools tab. 



	 
	 

	Figure
	5.
	5.
	5.
	 In the Task Selector pane, select the User Access hyperlink.  
	 In the Task Selector pane, select the User Access hyperlink.  
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	6.
	6.
	6.
	 In the User Access pane, in the Last Name column, select the last name hyperlink of the user to edit.  
	 In the User Access pane, in the Last Name column, select the last name hyperlink of the user to edit.  
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	7.
	7.
	7.
	 In the Account User Information section:  
	 In the Account User Information section:  


	d.
	d.
	 Edit the User Role and/or Access To Top Account options if needed.  
	 Edit the User Role and/or Access To Top Account options if needed.  


	e.
	e.
	 Select the Continue button to view the current access for the user.  
	 Select the Continue button to view the current access for the user.  
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	8.
	8.
	8.
	 In the Single Sign-on Partner Access section:  
	 In the Single Sign-on Partner Access section:  


	f.
	f.
	 To edit importer permissions, select the Importer sub-tab.  
	 To edit importer permissions, select the Importer sub-tab.  



	NOTE: To edit broker permissions, in the Broker sub-tab, select the Edit Broker Permissions hyperlink. 
	NOTE: To edit broker permissions, in the Broker sub-tab, select the Edit Broker Permissions hyperlink. 

	g.
	g.
	g.
	 Select the Edit Importer Permissions hyperlink. 
	 Select the Edit Importer Permissions hyperlink. 
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	9.
	9.
	9.
	 In the Authorized Tab Access section:  
	 In the Authorized Tab Access section:  


	h.
	h.
	 In the CBP Forms row, select the No Access or Full Access radio button. 
	 In the CBP Forms row, select the No Access or Full Access radio button. 



	NOTE: Full Access allows the user to view and respond to CBP Forms in the ACE Forms Application. No Access prevents access to CBP Forms. Read Only Access is NOT available for CBP Forms.  
	NOTE: Full Access allows the user to view and respond to CBP Forms in the ACE Forms Application. No Access prevents access to CBP Forms. Read Only Access is NOT available for CBP Forms.  

	i.
	i.
	i.
	 Select Continue.  
	 Select Continue.  



	 
	 

	Figure
	  
	  

	10.
	10.
	10.
	 The Permission column displays the updated settings. Select the Save button. 
	 The Permission column displays the updated settings. Select the Save button. 
	 The Permission column displays the updated settings. Select the Save button. 




	 
	 

	Figure
	 for the steps to locate your pending CBP form(s). 
	Topic 4: Access the ACE Forms Application Through Modernized ACE

	11.
	11.
	11.
	 In the Forms Search Results pane, in the Form Type column, select a form 4647 hyperlink. 

	12.
	12.
	 In the Details for Entry # pane, select Respond from the Action drop-down menu. 
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	NOTE: Select Generate PDF from the Action drop-down menu to create a PDF of the form.  
	Figure
	13.
	13.
	13.
	 Skip to step 5 if the merchandise is not going to be exported or destroyed. 
	a.
	a.
	a.
	 In the Merchandise To be: field, select either the Exported radio button or Destroyed under CBP supervision in lieu of marking or other required corrective measures radio button. 





	If the merchandise is to be exported or destroyed, complete the following steps in the Respond to CBP Form 4647: Notice to Mark and/or Notice to Redeliver dialog box, in the Importer Certification section: 
	b.
	b.
	b.
	 In the Place field, type the place where the merchandise was either exported or destroyed. 

	c.
	c.
	 In the Date field, select the Calendar icon and select the date the merchandise was either exported or destroyed. 

	d.
	d.
	 In the Time field, type the time the merchandise was either exported or destroyed. 


	 
	Figure
	14.
	14.
	14.
	 In the Respond to CBP Form 4647: Notice to Mark and/or Notice to Redeliver dialog box, in the Importer Certification section: 


	NOTE: This step is for merchandise that is not going to be exported or destroyed.  
	Figure
	 
	a.
	a.
	a.
	 Select the radio button in the I certify that all merchandise has been marked to indicate the country of origin as required by 19 U.S.C. 1304 or otherwise brought into compliance with statute(s) or regulation(s) field. 

	b.
	b.
	 In the Sample is, is not submitted herein field, select a radio button. 

	c.
	c.
	 In the Place field, type the place where the merchandise is being held. 

	d.
	d.
	 In the Telephone field, type your telephone number. 
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	15.
	15.
	15.
	 In the I (we) guarantee the payment of all expenses incident to the above action section: 
	Figure


	a.
	a.
	 In the Name field, type your name. 

	b.
	b.
	 In the Title field, type your title.  

	c.
	c.
	 In the Telephone field, type your telephone number. 

	d.
	d.
	 In the Email field, type your email address. 

	16.
	16.
	 Select the Add Attachment button, if appropriate.  
	Figure


	a.
	a.
	 Select the file to attach.  


	b.
	b.
	b.
	 Select the Open button. The file name displays beside the Upload Document To DIS button. 
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	c.
	c.
	c.
	 Select the Upload Document To DIS button. The uploaded file displays in the attachment list.  


	 
	Figure
	17.
	17.
	17.
	 Select the Save and Send button. 
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	TOPIC 8: RESPOND TO CBP FORM 6051D 
	INTRODUCTION 
	Importers with ACE Portal access can respond to a CBP Form 6051D via the ACE Forms application.  
	Figure
	NOTE: Required fields are indicated by a red asterisk.  
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	COMPLETE A FORM 6051D RESPONSE 

	1.
	1.
	 Access CBP Forms.  

	2.
	2.
	 If needed, refer to 
	Topic 3: TAOs – Authorize Access to CBP Forms 
	Topic 3: TAOs – Authorize Access to CBP Forms 



	3.
	3.
	 Introduction 
	 Introduction 



	In addition to granting access to the Mode of Communication hyperlink, the TAO must set CBP Forms permissions for PTAOs and authorized trade account users.  
	In addition to granting access to the Mode of Communication hyperlink, the TAO must set CBP Forms permissions for PTAOs and authorized trade account users.  

	The ACE Forms application allows authorized users to receive and respond to U.S. Customs and Border Protection (CBP) forms and requests: 
	The ACE Forms application allows authorized users to receive and respond to U.S. Customs and Border Protection (CBP) forms and requests: 

	•
	•
	•
	 CBP Form 28: Request for Information  
	 CBP Form 28: Request for Information  


	•
	•
	 CBP Form 29: Notice of Action 
	 CBP Form 29: Notice of Action 


	•
	•
	 CBP Form 4647: Notice to Mark/Notice to Re-Deliver 
	 CBP Form 4647: Notice to Mark/Notice to Re-Deliver 


	•
	•
	 CBP Form 6051D: Notice of Detention  
	 CBP Form 6051D: Notice of Detention  


	•
	•
	 CBP Documents Required Notifications 
	 CBP Documents Required Notifications 



	You must complete the following actions to receive, review, and respond to CBP forms in the ACE Forms application: 
	You must complete the following actions to receive, review, and respond to CBP forms in the ACE Forms application: 

	9.
	9.
	9.
	 The account Mode of Communication must be set to Portal. 
	 The account Mode of Communication must be set to Portal. 
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	10.
	10.
	10.
	 The TAO must authorize access to CBP Forms for PTAOs and/or other trade account users as needed. 
	 The TAO must authorize access to CBP Forms for PTAOs and/or other trade account users as needed. 



	 
	 

	Figure
	Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can receive, view, search and respond to CBP Forms through the ACE Forms application. 
	Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can receive, view, search and respond to CBP Forms through the ACE Forms application. 
	Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can receive, view, search and respond to CBP Forms through the ACE Forms application. 


	NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required to respond through the ACE Forms application. They may submit responses through the ACE Forms application or to CBP at the port of entry where the entry summary is filed. 
	NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required to respond through the ACE Forms application. They may submit responses through the ACE Forms application or to CBP at the port of entry where the entry summary is filed. 
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	SET CBP FORMS PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS 
	SET CBP FORMS PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS 



	4.
	4.
	 Select the Tools tab. 
	 Select the Tools tab. 
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	5.
	5.
	5.
	 In the Task Selector pane, select the User Access hyperlink.  
	 In the Task Selector pane, select the User Access hyperlink.  
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	6.
	6.
	6.
	 In the User Access pane, in the Last Name column, select the last name hyperlink of the user to edit.  
	 In the User Access pane, in the Last Name column, select the last name hyperlink of the user to edit.  
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	7.
	7.
	7.
	 In the Account User Information section:  
	 In the Account User Information section:  


	d.
	d.
	 Edit the User Role and/or Access To Top Account options if needed.  
	 Edit the User Role and/or Access To Top Account options if needed.  


	e.
	e.
	 Select the Continue button to view the current access for the user.  
	 Select the Continue button to view the current access for the user.  
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	8.
	8.
	8.
	 In the Single Sign-on Partner Access section:  
	 In the Single Sign-on Partner Access section:  


	f.
	f.
	 To edit importer permissions, select the Importer sub-tab.  
	 To edit importer permissions, select the Importer sub-tab.  



	NOTE: To edit broker permissions, in the Broker sub-tab, select the Edit Broker Permissions hyperlink. 
	NOTE: To edit broker permissions, in the Broker sub-tab, select the Edit Broker Permissions hyperlink. 

	g.
	g.
	g.
	 Select the Edit Importer Permissions hyperlink. 
	 Select the Edit Importer Permissions hyperlink. 
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	9.
	9.
	9.
	 In the Authorized Tab Access section:  
	 In the Authorized Tab Access section:  


	h.
	h.
	 In the CBP Forms row, select the No Access or Full Access radio button. 
	 In the CBP Forms row, select the No Access or Full Access radio button. 



	NOTE: Full Access allows the user to view and respond to CBP Forms in the ACE Forms Application. No Access prevents access to CBP Forms. Read Only Access is NOT available for CBP Forms.  
	NOTE: Full Access allows the user to view and respond to CBP Forms in the ACE Forms Application. No Access prevents access to CBP Forms. Read Only Access is NOT available for CBP Forms.  

	i.
	i.
	i.
	 Select Continue.  
	 Select Continue.  
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	10.
	10.
	10.
	 The Permission column displays the updated settings. Select the Save button. 
	 The Permission column displays the updated settings. Select the Save button. 
	 The Permission column displays the updated settings. Select the Save button. 
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	 for the steps to locate your pending CBP form(s). 
	Topic 4: Access the ACE Forms Application Through Modernized ACE

	11.
	11.
	11.
	 In the Forms Search Results pane, in the Form Type column, select a CBP Form 6051D hyperlink. 

	12.
	12.
	 In the Details for Entry Number pane, in the Action dropdown, select Respond. 


	 
	Figure
	13.
	13.
	13.
	 In the Form 6051D Response pane, enter the required information for Name, Telephone, Title, and Email.  
	Figure



	 
	  
	14.
	14.
	14.
	 Certify that the information provided is correct by reading the certification statement and checking the box.  
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	15.
	15.
	15.
	 Certify that there are no further supporting documents by reading the certification statement and checking the box. 


	 IMPORTANT: Users will have the ability to respond to the 6051D form as many 
	Figure
	 times as they desire before the due date, provided they do not certify “no further supporting documents are forthcoming”. Once a user certifies there are no further supporting documents forthcoming, or the due date has passed, they will not be able to respond to the form.  
	Figure
	16.
	16.
	16.
	 Select the Add Attachment button to add supporting documents. 


	 
	Figure
	IMPORTANT: All uploaded documentation will be stored in the ACE Document Image System (DIS).  Documents submitted via DIS should be named to easily identify the document.  Documents submitted for Withhold Release Order (WRO)/UFLPA detentions should be named based on the production process stage or the producer name. For example, documents submitted for solar cell producer X or for solar cells stage should be named as solar cell producer X: invoice; solar cell producer X: contract; solar producer X: delivery
	Figure
	The maximum individual file size that can be submitted DIS is 10 MB. 
	Figure
	NOTE: Successfully added attachments display in the table below the Add Attachment button. Navigate the table, if required, by using the Filter field or the navigation buttons.  
	  
	17.
	17.
	17.
	 Select the Save button. 


	 
	Figure
	The Details for Entry Number pane displays, and the Status will be updated to Response Received. 
	 
	Figure
	 
	 
	 
	TOPIC 9: RESPOND TO DOCUMENTS REQUIRED NOTICE 
	INTRODUCTION 
	A CBP employee can initiate an electronic post summary request for additional documentation to the filer. You can respond to documents required notifications through the ACE Forms application. 
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	RESPOND TO A DOCUMENTS REQUIRED MESSAGE 

	1.
	1.
	 Access CBP Forms.  

	2.
	2.
	 If needed, refer to 
	Topic 3: TAOs – Authorize Access to CBP Forms 
	Topic 3: TAOs – Authorize Access to CBP Forms 



	3.
	3.
	 Introduction 
	 Introduction 



	In addition to granting access to the Mode of Communication hyperlink, the TAO must set CBP Forms permissions for PTAOs and authorized trade account users.  
	In addition to granting access to the Mode of Communication hyperlink, the TAO must set CBP Forms permissions for PTAOs and authorized trade account users.  

	The ACE Forms application allows authorized users to receive and respond to U.S. Customs and Border Protection (CBP) forms and requests: 
	The ACE Forms application allows authorized users to receive and respond to U.S. Customs and Border Protection (CBP) forms and requests: 

	•
	•
	•
	 CBP Form 28: Request for Information  
	 CBP Form 28: Request for Information  


	•
	•
	 CBP Form 29: Notice of Action 
	 CBP Form 29: Notice of Action 


	•
	•
	 CBP Form 4647: Notice to Mark/Notice to Re-Deliver 
	 CBP Form 4647: Notice to Mark/Notice to Re-Deliver 


	•
	•
	 CBP Form 6051D: Notice of Detention  
	 CBP Form 6051D: Notice of Detention  


	•
	•
	 CBP Documents Required Notifications 
	 CBP Documents Required Notifications 



	You must complete the following actions to receive, review, and respond to CBP forms in the ACE Forms application: 
	You must complete the following actions to receive, review, and respond to CBP forms in the ACE Forms application: 

	11.
	11.
	11.
	 The account Mode of Communication must be set to Portal. 
	 The account Mode of Communication must be set to Portal. 
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	12.
	12.
	12.
	 The TAO must authorize access to CBP Forms for PTAOs and/or other trade account users as needed. 
	 The TAO must authorize access to CBP Forms for PTAOs and/or other trade account users as needed. 



	 
	 

	Figure
	Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can receive, view, search and respond to CBP Forms through the ACE Forms application. 
	Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can receive, view, search and respond to CBP Forms through the ACE Forms application. 
	Once the TAO authorizes the Mode of Communication and access to CBP Forms permissions, the user can receive, view, search and respond to CBP Forms through the ACE Forms application. 


	NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required to respond through the ACE Forms application. They may submit responses through the ACE Forms application or to CBP at the port of entry where the entry summary is filed. 
	NOTE: Accounts electing to receive copies of forms through the Portal (ACE Forms application) are not required to respond through the ACE Forms application. They may submit responses through the ACE Forms application or to CBP at the port of entry where the entry summary is filed. 
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	SET CBP FORMS PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS 
	SET CBP FORMS PERMISSIONS FOR PTAOS AND TRADE ACCOUNT USERS 



	4.
	4.
	 Select the Tools tab. 
	 Select the Tools tab. 
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	5.
	5.
	5.
	 In the Task Selector pane, select the User Access hyperlink.  
	 In the Task Selector pane, select the User Access hyperlink.  
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	6.
	6.
	6.
	 In the User Access pane, in the Last Name column, select the last name hyperlink of the user to edit.  
	 In the User Access pane, in the Last Name column, select the last name hyperlink of the user to edit.  
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	7.
	7.
	7.
	 In the Account User Information section:  
	 In the Account User Information section:  


	j.
	j.
	 Edit the User Role and/or Access To Top Account options if needed.  
	 Edit the User Role and/or Access To Top Account options if needed.  


	k.
	k.
	 Select the Continue button to view the current access for the user.  
	 Select the Continue button to view the current access for the user.  
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	8.
	8.
	8.
	 In the Single Sign-on Partner Access section:  
	 In the Single Sign-on Partner Access section:  


	l.
	l.
	 To edit importer permissions, select the Importer sub-tab.  
	 To edit importer permissions, select the Importer sub-tab.  



	NOTE: To edit broker permissions, in the Broker sub-tab, select the Edit Broker Permissions hyperlink. 
	NOTE: To edit broker permissions, in the Broker sub-tab, select the Edit Broker Permissions hyperlink. 

	m.
	m.
	m.
	 Select the Edit Importer Permissions hyperlink. 
	 Select the Edit Importer Permissions hyperlink. 
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	9.
	9.
	9.
	 In the Authorized Tab Access section:  
	 In the Authorized Tab Access section:  


	n.
	n.
	 In the CBP Forms row, select the No Access or Full Access radio button. 
	 In the CBP Forms row, select the No Access or Full Access radio button. 



	NOTE: Full Access allows the user to view and respond to CBP Forms in the ACE Forms Application. No Access prevents access to CBP Forms. Read Only Access is NOT available for CBP Forms.  
	NOTE: Full Access allows the user to view and respond to CBP Forms in the ACE Forms Application. No Access prevents access to CBP Forms. Read Only Access is NOT available for CBP Forms.  

	o.
	o.
	o.
	 Select Continue.  
	 Select Continue.  
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	10.
	10.
	10.
	 The Permission column displays the updated settings. Select the Save button. 
	 The Permission column displays the updated settings. Select the Save button. 
	 The Permission column displays the updated settings. Select the Save button. 




	 
	 

	Figure
	 for the steps to locate your pending CBP form(s).  
	Topic 4: Access the ACE Forms Application Through Modernized ACE

	11.
	11.
	11.
	 In the Forms Search Results pane, in the Form Type column, select a Docs Required hyperlink. 

	12.
	12.
	 In the Details for Entry # pane, select Respond from the Action drop-down menu. 


	 
	Figure
	13.
	13.
	13.
	 In the Send Response dialog box:  
	Figure


	a.
	a.
	 In the Name field, type your name.  

	b.
	b.
	 In the Telephone field, type your telephone number. 

	c.
	c.
	 In the Title field, type your title.  

	d.
	d.
	 In the Email field, type your email address. 


	14.
	14.
	14.
	 Select the Add Attachment button.  
	Figure
	a.
	a.
	a.
	 Select the file to attach.  

	b.
	b.
	 Select the Open button.  
	Figure


	c.
	c.
	 Select the Upload Document To DIS button.  





	The file name displays beside the Upload Document To DIS button. 
	 
	The uploaded file displays in the attachment list.  
	 
	Figure
	15.
	15.
	15.
	 Select the Save and Send button. 
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	TOPIC 10: FORMAT ATTACHMENTS FOR UPLOAD  
	INTRODUCTION 
	The CBP preferred file types for document submission include:  
	-
	-
	-
	 PDF 

	-
	-
	 GIF 

	-
	-
	 PNG 

	-
	-
	 JPG 

	-
	-
	 JPEG 

	-
	-
	 XLS, XLSX (for specific programs such as CBMA) 


	There are additional file types that may be submitted and accepted for upload. CBP recommends the above listed types for image quality and ease of upload.   
	Individual attachment size cannot exceed 10 MB. 
	Figure
	 
	 



